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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published May 2015. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  



 

 

Installation Guide iii 

 

Contents 

Overview .......................................................................................................................................... 1 

Adding Custom Notes to This Guide ........................................................................................... 1 

If You Need Assistance ................................................................................................................... 2 

Customer Services ...................................................................................................................... 2 

Customer Care Connect Site ...................................................................................................... 2 

Additional Documentation ........................................................................................................... 3 

Downloading Deltek Products using Deltek Software Manager ...................................................... 5 

Accessing DSM Directly .............................................................................................................. 5 

Accessing DSM from within the Customer Care Connect Site ................................................... 6 

Accessing DSM Lite .................................................................................................................... 6 

DSM Documentation and Troubleshooting ................................................................................. 7 

Prerequisites .................................................................................................................................... 8 

Deltek Integrated Products .......................................................................................................... 8 

Database Tier .............................................................................................................................. 8 

Client Tier .................................................................................................................................... 8 

Upgrading from Earlier Versions of Open Plan ............................................................................. 10 

Upgrade the Database .............................................................................................................. 10 

Open Plan Installation Wizard ....................................................................................................... 12 

Installing a Single-User Version of Open Plan .............................................................................. 13 

Performing a Multi-User Installation of Open Plan ........................................................................ 18 

Perform Server Installation ........................................................................................................ 18 

Perform a Workstation Installation ............................................................................................ 22 

Deltek Folder ................................................................................................................................. 25 

Start Menu ................................................................................................................................. 25 

Documentation .......................................................................................................................... 25 

Security ..................................................................................................................................... 25 

Tools .......................................................................................................................................... 25 

Starting Open Plan for the First Time ............................................................................................ 26 

Open Plan Databases ................................................................................................................... 27 

Access ....................................................................................................................................... 27 

Oracle and SQL Server ............................................................................................................. 27 

Database Size ........................................................................................................................... 27 

Transaction Log Size................................................................................................................. 27 

Database Permissions .............................................................................................................. 27 

Open Plan Tables ...................................................................................................................... 28 



 

 

Installation Guide iv 

 

Set Up a Database .................................................................................................................... 28 

Run Oracle Scripts for PM Compass and Cobra Integration .................................................... 28 

Open Plan Data Tool ..................................................................................................................... 30 

Log On to the Open Plan Data Tool .......................................................................................... 30 

Choose a Data Source .............................................................................................................. 30 

Define a New Data Source ........................................................................................................ 30 

Load Default Data ..................................................................................................................... 35 

Load Data for an Additional Product ......................................................................................... 36 

Launching the EPM Security Administrator ................................................................................... 38 

Set Up Security ......................................................................................................................... 38 

Create a User ............................................................................................................................ 38 

Create a Group .......................................................................................................................... 39 

Add a User to a Group .............................................................................................................. 39 

Open Plan Folder Permissions ...................................................................................................... 40 

Modifying, Repairing, or Uninstalling Open Plan ........................................................................... 41 

Where to Go from Here ................................................................................................................. 43 

Appendix:  Deltek Open Plan 3.5 Terminal Services (Remote Desktop Services)/Citrix Installation
 ....................................................................................................................................................... 44 

Overview ................................................................................................................................... 44 

Version Information ................................................................................................................... 44 

Important Information ................................................................................................................ 44 

Database Connections .............................................................................................................. 44 

Server Sizing ............................................................................................................................. 45 

Terminal Server/Citrix Installation ............................................................................................. 45 

Security Considerations ............................................................................................................ 45 

Logon as the limited user .......................................................................................................... 47 

Modifying the User Directory ..................................................................................................... 48 

Open Plan Desktop ................................................................................................................... 48 

 

 

 



Overview 

 

Installation Guide 1 

 

Overview 

Welcome to Deltek® Open Plan™ 3.5, your comprehensive solution to project planning and 
management tasks. Designed to cope with the most demanding requirements of project planners, 
Open Plan has the capability and the flexibility to handle even the largest projects. At the same 
time, Open Plan takes advantage of its graphical interface design to make its power accessible to 
even the most inexperienced user. 

This guide provides information on the following topics: 

 System requirements for Open Plan 

 Procedures for installing single and multi-user versions of Open Plan 

 Description of the Deltek program group 

 Discussion on starting Open Plan for the first time  

 Procedures for setting up Security Administrator 

 Procedures for setting up a database 

 Discussion of installations that include copies of both Open Plan Professional and Open 
Plan Desktop 

 Requirements of the Microsoft Project Import/Export utilities 

 Procedures for removing Open Plan from your computer 

 Information on contacting Deltek technical support 

This guide concludes with a discussion of the various types of documentation supplied with the 
Open Plan application. 

Adding Custom Notes to This Guide 

If you would like to add custom notes to this guide that are specific to your company, Adobe
®
 

Reader
®
 X provides this ability. If you do not already use Adobe Reader X, you can download it 

here free from Adobe.  

To add a custom note using Adobe Reader X, complete the following steps: 

1. On the Reader toolbar, click Comment at far right. 

2. In the Annotations pane that displays, click  Sticky Note. The cursor changes to 
match the button. 

3. Position the cursor at the location in the guide where you want the note to appear, and 
click. A note icon is inserted at the location and a text box pops up. 

4. Enter your information in the text box.   

5. Continue adding notes as needed. 

6. Save the document. 

 

Deltek recommends that you save the document to a slightly different filename so as to keep the 
original from being overwritten. 

When reading the document, cursor over a note icon to see the information. Double-click a note 
icon to edit the information. 

http://get.adobe.com/reader/
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If You Need Assistance 

If you need assistance installing, implementing, or using Open Plan, Deltek makes a wealth of 
information and expertise readily available to you. 

Customer Services 

For over 30 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Find out more about these and other services from the Customer Care Connect site. 

Customer Care Connect Site 

The Deltek Customer Care Connect site is a support Web portal for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options you have at the Customer Care Connect site: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Subscribe to Deltek communications about your Deltek products and services 

 Receive alerts of new Deltek releases and hot fixes 

 

If you need assistance using the Customer Care Connect site, the online help available on the 
site provides answers for most questions  
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Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps:  

1. Go to http://support.deltek.com. 

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you do not have a username and password for the Customer Care Connect site, contact your 

firm’s Open Plan Administrator. 

If you forget your username or password, you can click the Account Assistance button on the 

login screen for help. 

Additional Documentation 

Release notes and other guides are available for this release. You can download these 
documents in two ways. 

Deltek Software Manager 

The Documents tab in Deltek Software Manager lists all of the documents associated with a 
release and lets you download the ones that you want.  

To download documents, complete the following steps: 

1. On the Deltek Customer Care site, click the Product Downloads tab, then select Launch 
Deltek Software Manager. 

2. When the Deltek Software Manager opens, highlight a release in the left pane. 

 

Do not enter a check next to the release name or click Add to 
Download Queue. If you do so, you will download the software as 
well as any documentation that you want. 

3. Click the Documents tab to display a list of available documents for the release. 

4. Select the documents that you want. 

5. Click View Download Queue to see a list of documents that you selected. 

6. Click Download. 

Customer Care Site Enterprise Search 

Use the search feature to find specific documents or to see a list of all documents associated with 
a release. Then open or download the ones that you want. 

To download documents, complete the following steps: 

1. On the Deltek Customer Care site, click Enterprise Search. 

2. Select Release Documentation as the Source. 

3. Perform one of the following actions:  

 To see a list of all available documentation for a release, enter the product and 
release number (for example, Vision 7.4) in the search field. 

http://support.deltek.com/
https://deltek.custhelp.com/app/home
https://deltek.custhelp.com/app/home
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 To find a specific document, enter a description of the document (for example, Vision 
7.4 release notes) in the search field. 

4. Click on the document, then choose to open or save it. 
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Downloading Deltek Products using Deltek 
Software Manager 

You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, 
and sub-releases. You can access DSM directly or through the Deltek Customer Care Connect 
site. 

When you access DSM directly, you will be prompted to log on before you can access the 
application. If you access DSM from within the Deltek Customer Care site, you do not have to log 
on since you are already logged into the Customer Care site. 

Accessing DSM Directly 

To access Deltek Software Manager directly, complete the following steps: 

1. Launch Deltek Software Manager by taking one of the following actions: 

 Click here.  

 On your desktop, click Start » All Programs » Deltek Software Manager. 

2. In the Deltek Software Manager logon dialog box, enter your Deltek Customer Care User 
ID and Password, and click Logon. 

3. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

 

When you log on for the first time, Deltek Software Manager asks you to select a 
default folder where Deltek products are to be downloaded.  

4. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

 

You can change this folder anytime in the Settings dialog box.  

5. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

 

If you clicked the link in step 1 to access DSM, the application automatically selects 
Open Plan for you. 

6. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

7. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

 

To view the items in the download queue, click View Download Queue at the bottom 

of the left pane.  

https://dsm.deltek.com/DeltekSoftwareManager/DeltekSoftwareManager.application?ProductVersionID=B723E107-D752-4D7E-B3DE-9BD8CC3B8A50
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8. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

Accessing DSM from within the Customer Care Connect Site 

To access Deltek Software Manager from within the Customer Care Connect site, complete 
the following steps: 

1. In your Web browser, go to http://support.deltek.com.  

2. Enter your Customer Care Connect Username and Password, and click Log In. 

3. When the Customer Care Connect site displays, click the Product Downloads tab. 

You are automatically logged into Deltek Software Manager. 

4. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

 

When you log on for the first time, Deltek Software Manager asks you to select a 
default folder where Deltek products are to be downloaded.  

5. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

 

You can change this folder anytime in the Settings dialog box.  

6. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

7. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

8. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

 

To view the items in the download queue, click View Download Queue at the bottom 

of the left pane.  

9. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

Accessing DSM Lite 

To access Deltek Software Manager Lite, complete the following steps: 

1. In your Web browser, go to https://dsm.deltek.com/DeltekSoftwareManagerLite.  

2. Enter your Customer Care Connect Username and Password, and click Logon. 

3. When the Deltek Software Manager Lite site displays, select a product from the drop-
down list. 

4. Click the product type that you want to download.  

http://support.deltek.com/
https://dsm.deltek.com/DeltekSoftwareManagerLite
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The download behavior and download folder may differ depending on the browser and 
browser settings that you are using. 

DSM Documentation and Troubleshooting 

 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

 

The above troubleshooting link will only work if you are logged into Deltek Customer 
Care Connect. 

https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469


Prerequisites 

 

Installation Guide 8 

 

Prerequisites  

To run Open Plan version 3.5 successfully, your system must meet the requirements listed in this 
section. 

Deltek Integrated Products 

 Open Plan is compatible with the following IPM products: 

 Deltek Cobra™ 5.1.2, 5.1.3 

 Deltek PM Compass 2.2 (PMC 2.2 is planned for release later this year. Check the 
compatibility when it is released.) 

 Deltek Acumen Suite 5.1, 6.0 (Fuse, Risk and 360) 

 

Open Plan users who are integrating data with these products must ensure that the 
products are upgraded to the compatible versions. 

Database Tier 

The following database platforms have been tested for compatibility and are fully supported by 
Open Plan: 

Operating System 

 Windows Server 2012 R2 

 Windows Server 2012 

 Windows Server 2008 R2 

 Windows Server 2008 

Database Platform 

 Oracle 12c R1, 11g R2 

 Microsoft SQL Server 2014, 2012, 2008 R2 

 Microsoft Access  

Client Tier 

The following client platforms have been tested for compatibility and are fully supported by Open 
Plan: 

Operating System 

 Windows 8.1 

 Windows 8 

 Windows 7 
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Windows Terminal Services/Citrix  

 Windows Server 2012 R2 

 Windows Server 2012 

 Windows Server 2008 R2 

 Windows Server 2008 

Integration Products (Optional) 

 Microsoft Project® 2013, 2010, 2007 
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Upgrading from Earlier Versions of Open Plan 

When upgrading from an earlier version of Open Plan, Open Plan 3.5 must be installed in a new 
folder rather than attempting to overwrite/upgrade an existing Open Plan installation. Open Plan 
3.5 supports concurrent installation with previous versions of Open Plan, provided that: 

 The user has Power User/Administrator rights (This is necessary to enable Open Plan to 
update OLE Automation Server registration when different versions are used) 

 The two versions do not share the same database 

 The two versions are installed to different folders 

It is necessary to perform a new Workstation installation for users that access Open Plan from a 
shared server installation. The Workstation setup application is available in the Workstation Setup 
folder of the server installation folder. 

Upgrade the Database 

Upgrading from an earlier version of Open Plan requires upgrading the database. Prior to 
upgrading, however, Deltek recommends backing up of the Open Plan database. Once 
upgraded, you can no longer use the database with a prior version of the application. 

 

 Before running the upgrade scripts, your Database Administrator must verify 
if the Open Plan database is in Unicode. If so, the appropriate setting in the 
script to upgrade the database in Unicode must be set. This, however, does 
not apply to MS Access. 

 If you are installing to a database that already contains another Deltek IPM 
application, you must select the same Unicode option as the existing 
applications 

 If you are upgrading 3.1a to 3.2:  

 For SQL, run OPP32_Upgrade_SqlServer.sql. 

 For Oracle, run OPP32_Upgrade_Oracle.sql. 

 If you are upgrading 3.2 to 3.3: 

 For SQL, run OPP33_Upgrade_SqlServer.sql. 

 For Oracle, run OPP33_Upgrade_Oracle.sql. 

 If you are upgrading 3.3 to 3.4: 

 For SQL, run OPP34_Upgrade_SqlServer.sql. 

 For Oracle, run OPP34_Upgrade_Oracle.sql. 

 If you are upgrading 3.4 to 3.4.1: 

 For SQL, run OPP341_Upgrade_SqlServer.sql. 

 For Oracle, run OPP341_Upgrade_Oracle.sql. 

 If you are upgrading 3.4.1 to 3.5: 

 For SQL, run OPP35_Upgrade_SqlServer.sql. 

 For Oracle, run OPP35_Upgrade_Oracle.sql. 



Upgrading from Earlier Versions of Open Plan 

 

Installation Guide 11 

 

 

The update scripts used in this procedure can be found in the Open Plan executable 
folder. 

 For MS SQL, you can find the scripts in the C:\Program Files 
(x86)\Deltek\Open Plan Professional 3.5\SQL\SQL Server folder.  

 For Oracle, you can find the scripts in the C:\Program Files (x86)\Deltek\Open 
Plan Professional 3.5\SQL\Oracle folder. 

 For MS Access, however, you can upgrade the database by backing up Open 
Plan data in the prior version of Open Plan and restoring the backup file to 
the latest version of Open Plan. This is only possible when the source file has 
the same major version as Open Plan’s (for example, 3.x.x.xxx). 
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Open Plan Installation Wizard 

Open Plan comes with an automated installation wizard that allows you to create the following 
types of installations: 

 Complete installation of all the files that come with your Open Plan package 

 Custom installation that copies only the features you plan to use  

 Multi-user installation on a network drive for shared use by multiple workstations 

After you have installed Open Plan, you can use the installation wizard to add features to your 
installation at any time. 
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Installing a Single-User Version of Open Plan 

This section describes how to install a single-user version of Open Plan on either a stand-alone 
PC or on a network drive. 

To install a single-user version of Open Plan, complete the following steps: 

1. Download the Open Plan 3.5 software using the instructions in the Downloading Deltek 
Products using Deltek Software Manager section. 

2. Go to the location where you saved the Open Plan installer. 

3. Double-click DeltekOpenPlanProfessional35.exe to extract the installation files and 
display the installation launch screen. 

4. On the installation launch screen, choose Install Open Plan to launch the Open Plan 3.5 
Setup Wizard. 
 

 

5. On the Welcome to the Open Plan 3.5.0 Setup Wizard page, click Next. 
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6. On the End-User License Agreement page, select I accept the terms in the License 
Agreement then click Next. 

 

7. On the Customer Information page, enter your user information then click Next. 

 

 

For your Open Plan serial number and password, please contact your Open Plan 
administrator. The Password is also known as the License Key. 



Installing a Single-User Version of Open Plan 

 

Installation Guide 15 

 

8. On the Change current destination folder page, take one of the following actions then 
click Next: 

 

 If necessary, select a destination for Open Plan by clicking the browse button. 

 If you are installing the Desktop version of Open Plan, you are asked if you want to 
share data with Open Plan Professional. If you click Yes, the installation wizard 
prompts you to locate the Open Plan Professional destination. 

9. On the Choose Setup Type page, select one of the following installation options: 

 

 Complete – Installs all Open Plan’s features. 

 Custom – Allows you to select or clear the individual Open Plan features.  

 Multi-User (Server) – Installs Open Plan to a network drive for shared use by 
multiple workstations. 
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Multi-User (Server) installation is covered in detail in the section entitled Performing a 
Multi-User Installation of Open Plan. 

 Standard – Allows you to create a minimal installation of Open Plan by installing only 
the files needed to run the program. 

 

If you do not choose to install a particular feature at this time, you can return to the 
installation wizard and add the feature later. 

10. On the Ready to Install page, click Install. 

 

The Installing Open Plan Professional 3.5.0 page shows the installation’s progress. 
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11. When the installation process is completed, click Finish on the Completing the Open 
Plan 3.5.0 Setup Wizard page. 
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Performing a Multi-User Installation of Open Plan  

Creating a multi-user installation of Open Plan is a two-step procedure: 

 Performing a server installation 

 Performing a workstation installation for each licensed user 

Perform Server Installation 

The purpose of the Multi-User (Server) installation is to allow multiple users to run the application 
from a shared network location. After performing the Server installation, each user must perform 
a Workstation installation in order to run the application from the shared network location. 

During the Multi-User (Server) installation, the destination folder path is written into the file 
Setup.ini located in the Workstation Setup folder. 

 

The destination folder path can be specified as either a UNC based \\server\folder path or a 
mapped drive:\folder path. If a mapped drive:\folder path is used, you must ensure that all the 

user workstations use the same drive:\folder mapping. 

Before you perform a Workstation installation, verify that the path in the Setup.ini file points to the 
correct network share location because the Workstation installation will use this path to create 
shortcuts and perform application registration on the workstation. 

 

The line in Setup.ini looks like this:  

UNC \\Server\Folder path:  PROPERTIES=INSTALLDIR="\\<Server>\<Destination Folder> \" 

Drive:\Folder path:  PROPERTIES=INSTALLDIR="<Drive>:\<Destination Folder> \". 

To perform a server installation, complete the following steps: 

1. Download the Open Plan 3.5 software, using the instructions in the Downloading Deltek 
Products using Deltek Software Manager section. 

2. Go to the location where you saved the Open Plan installer. 

3. Double-click DeltekOpenPlanProfessional35.exe to extract the installation files and 
display the installation launch screen. 
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4. On the installation launch screen, choose Install Open Plan to launch the Open Plan 3.5 
Setup Wizard. 

 

5. On the Welcome to the Open Plan 3.5.0 Setup Wizard page, click Next. 
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6. On the End-User License Agreement page, select I accept the terms in the License 
Agreement then click Next. 

 

7. On the Customer Information page, enter your user information then click Next. 

 

 

For your Open Plan serial number and password, please contact your Open Plan 
administrator. The Password is also known as the License Key. 
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8. On the Change current destination folder page, take one of the following actions then 
click Next: 

 

 If necessary, select a destination for Open Plan by clicking the browse button. 

 If you are installing the Desktop version of Open Plan, you are asked if you want to 
share data with Open Plan Professional. If you click Yes, the installation wizard 
prompts you to locate the Open Plan Professional destination. 

9. On the Choose Setup Type page, select Multi-User (Server). 
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10. On the Ready to Install page, click Install. 

 

The Installing Open Plan Professional 3.5.0 page shows the installation’s progress. 

11. When the installation process is completed, click Finish on the Completing the Open 
Plan 3.5.0 Setup Wizard page. 

 

Perform a Workstation Installation 

After the server version of Open Plan has been installed on a network drive, use this procedure to 
create multiple workstation installations. 

 

 You can create workstation installations only from a server installation of Open Plan. 

 Although similar to the single-user installation, the workstation installation does not 
prompt you to enter a serial number and password. 

 You need to perform the workstation install on every computer on which Open Plan 
needs to run. 
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To perform a workstation installation of Open Plan, complete the following steps: 

1. Verify that a server installation of Open Plan has already been placed on the network. 

2. Using Windows Explorer, locate the Open Plan server installation. On the server 
installation, navigate to the root folder for the workstation. For example, C:\Deltek\Open 
Plan Professional 3.5\Workstation Setup. 

3. Double-click setup.exe. Open Plan displays the Welcome page of the installation wizard. 
Click Next. 

 

4. On the Choose Setup Type page, select one of the following: 

 Administrator – the procedure installs all of the features of the Standard setup are 
together with the Security Administrator and the Data Tool. 

 Standard – the procedure installs the Open Plan Help system, documents, default 
access, data source, OLE setup, and Web Publisher. 

 

5. On the Ready to Install page, click Install. 
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The Installing Open Plan Professional 3.5.0 (Workstation) page shows the 
installation’s progress. 

6. When the installation process is completed, click Finish on the Completing the Open 
Plan 3.5.0 (Workstation) Setup Wizard page. 

 

 

If you try to launch Open Plan after performing a workstation installation and receive an error 
saying the Data Sources could not be located, you will need to check that the paths to these files 
are mapped to the correct server. This is done by opening the Config.dat file located in the 

Open Plan root folder. 
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Deltek Folder 

Start Menu 

In addition to a shortcut to the Open Plan application, the installation creates several folders with 
shortcuts under the Deltek » Open Plan Professional 3.5 folder. 

Documentation 

The following reference materials are available in the Documentation folder: 

 Open Plan User Guide – An Open Plan user reference manual. 

 Open Plan Developer Guide – A reference manual for more technical topics in Open 
Plan. 

 Open Plan Release Notes – A document that discusses the new features and 
enhancements of this release, changes to the documentation, and the Software Issues 
Resolved. 

 Open Plan Guided Tour – An introduction to Open Plan. 

The following reference materials are also in the Help folder: 

 Open Plan Help System – The Open Plan context-sensitive help system. 

 Open Plan Log Viewer Help System – The help system for the Open Plan Log Viewer. 
To access this, from within Open Plan, click View » Log Viewer and then click Help » 
Contents. 

 EPM Security Administrator Help System – The help system for the EPM Security 
Administrator. To access this, click the Help button after launching EPM Security 
Administrator or click Help » Contents within the application. 

Security 

EPM Security Administrator – This is a Deltek security management application. (Open Plan 
Professional installations only) 

Tools 

The following applications are represented in this folder: 

 OLE Setup – An application that allows you to ensure that the correct version of OLE 
automation is invoked when you switch between different versions of Open Plan. 

 Open Plan Web Publisher – The stand-alone version of the Open Plan Web Publisher 
application. 

 Data Tool – A utility to set up the default system data, security data, and optionally, the 
demonstration data. 
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Starting Open Plan for the First Time 

If you used the setup utility to install Open Plan, you can start the application on the Start menu. 

 

To start Open Plan automatically each time you enter Windows, drag the Open Plan application 
into the Windows Startup folder. For more information about the Startup program group, see 
your Windows documentation. 

You must log on each time you launch Open Plan. You may log on to Open Plan for the first time 
as an administrator or a guest. 

To start Open Plan, complete the following steps: 

1. Click Start » Programs » Deltek » Open Plan Professional 3.5, and click the icon 
representing your installation of Open Plan. 

2. On the Open Plan Login dialog box, log on as SYSADMIN or GUEST with the 
corresponding password. 

 Administrator: 

 User ID: SYSADMIN 

 Password: PASSWORD 

 Guest: 

 User ID: GUEST 

 Password: <blank> 

3. Click Login. 

 

The first time you launch Open Plan, your default user name is the Windows user name that you 
use to log on to a computer. Deltek recommends that you replace this user name with your 
Open Plan user name.  
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Open Plan Databases 

Open Plan supports Access, Oracle, and SQL Server databases through an OLEDB 2.1 
compliant provider.  

 

For the list of supported OLEDB providers for each database type, see Open Plan Data Tool.  

Access 

A default Access database is automatically created when Open Plan is installed and Open Plan is 
configured to use this database by default. 

Oracle and SQL Server 

If you prefer to have Open Plan use an Oracle or SQL Server database, you first need to create 
tables and define a data source. When you configure an SQL database, you must consider 
several aspects regarding the database itself: 

 Database size 

 Transaction log size 

 Database permissions 

 

Upgrading from an earlier version of Open Plan requires upgrading the database. The update 
scripts are located in the Open Plan executable folder. For more information, see Upgrading 
from Earlier Versions of Open Plan. 

Database Size 

When creating the Open Plan database, you must consider the number of anticipated project 
elements that will be created in Open Plan and the number of records the project elements will 
contain. Generally, each project activity uses 3000-4000 bytes. Each project baseline adds an 
additional 2000-3000 bytes per project activity. Note records contain variable length free-form text 
and can add up to an additional 32,000 bytes for each note category in use. 

Following these rules, a typical 1000-activity project with two baselines and notes containing 200 
bytes of text on 20% of the activities would require approximately 10 MB of disk space, not 
including database-specific overhead. You can use the Excel spreadsheet (sizing30.xls) located 
in the Open Plan destination folder to help estimate disk requirements. 

Transaction Log Size 

Open Plan performs updates on large numbers of database table rows when saving changes to 
project data. Transaction logs must be sized appropriately to allow for these types of operations. 

Database Permissions 

To create and modify project elements in the database, you must have the following permissions 
on the Open Plan tables: SELECT, INSERT, UPDATE, DELETE, and EXECUTE. 
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It is not necessary to create a separate user account for each Open Plan user on the database, 
nor is it necessary for users to see the database login prompts. 

Open Plan Tables 

During the installation, the subfolder \SQL is created. This subfolder contains folders for Oracle 
and SQL Server scripts. To begin, you or your database administrator must create a database to 
hold the Open Plan tables. After this has been completed, return to this page of the Installation 
Guide to proceed. 

 

The scripts for creating tables on SQL Server and Oracle default to a Unicode installation. 

Oracle Scripts 

If you are using Oracle, run the following scripts located in the Oracle subfolder: 

 Opp_Tables_Oracle.sql 

 WST_Tables_Oracle.sql  

SQL Server Script 

If using SQL Server, run the following scripts located in the SQL Server subfolder: 

 Opp_Tables_SqlServer.sql 

 WST_Tables_SqlServer.sql 

Set Up a Database 

This procedure allows you to set up a database using either Oracle or SQL server. 

To set up the database, complete the following steps: 

1. Navigate to your Open Plan installation folder. 

2. Expand the contents of your Open Plan installation folder, and click the SQL folder. 

3. Open the subfolder that matches the type of database you want to set up: Oracle or 
SqlServer. 

4. Select the scripts (mentioned in the previous subsection) to run based on whether you 
are using Oracle or SQL Server.  

Run Oracle Scripts for PM Compass Integration 

You must run the following scripts if you are integrating Open Plan with PM Compass in the same 
Oracle schema: 

Script  Description Location 

Opp_Oracle_CI_Indexes.sql Run this script to create Case 
Insensitive indexes in Open Plan tables 
for integration with PM Compass. 

For explicit Tablespace support, set the 

\SQL\Oracle\Utility 
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Script  Description Location 

index_tablespace variable in the 
DECLARE section. 

To control the type of indexes that are 
created,  see the indextype variable in 
the DECLARE section. 

WST_Oracle_CI_Indexes.sql Run this script to create Case 
Insensitive indexes on WST tables for 
integration with PMCompass. 

For explicit Tablespace support, set the 
index_tablespace variable in the 
DECLARE section. 

To control the type of indexes that are 
created,  see the indextype variable in 
the DECLARE section. 

\SQL\Oracle\Utility 

 

 

 If your Open Plan installation is in the same schema as your PM Compass installation, 
you must run Opp_Oracle_CI_Indexes.sql.  

 If Open Plan was installed first followed by PM Compass, you must run both 
Opp_Oracle_CI_Indexes.sql and WST_Oracle_CI_Indexes.sql.  

 If PM Compass was installed first followed by Open Plan, you only need to run 
Opp_Oracle_CI_Indexes.sql. 
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Open Plan Data Tool 

Once you have created a database and the Open Plan tables, the database must be initialized 
before it can be used. The Open Plan Data Tool is provided for this purpose. The Open Plan Data 
Administrator sets up the default system data, security data, and optionally, the demonstration 
data. 

Log On to the Open Plan Data Tool 

This procedure is not required for the supplied Microsoft Access databases. 

To log in to the Data Tool, complete the following steps: 

1. Click Start » All Programs » Deltek » Open Plan Professional 3.5 » Tools » Data 
Tool. The Data Sources dialog box displays. 

2. Click OK. The Data Tool Login dialog box displays. 

3. Enter the password. (The default password as shipped from Deltek is password.) 

4. Click OK. The Open Plan Data Administrator dialog box displays. 

 

Deltek recommends that you change the password you used for login to prevent its 
unauthorized use. To change the password, click Password on the Open Plan Data 

Administrator dialog box, and enter a new password when prompted. 

Choose a Data Source 

If you already have another edition of Open Plan installed and you want to update the data 
source, see the “Loading Data for an Additional Product” section of this document. 

To connect to a newly created database, you must add an Open Plan data source. An Open Plan 
data source has all the connection information that Open Plan needs in order to work with a 
database. 

Define a New Data Source 

To add a new data source, complete the following steps: 

1. On the Open Plan Data Administrator dialog box, click  at the right edge of the Target 
DSN field. The Data Sources dialog box displays. 

2. Click Add. The Data Link Properties dialog box displays. This dialog box displays the 
Provider tab with a list of database providers on your system. 

3. Select the appropriate database provider. 

4. After you select a provider, click Next. The Connection tab displays. 
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Data Source Providers and Database Types  

The following table lists the data source providers to use for each database type: 

Data Source Provider Database Type 

SQL Server Microsoft OLE DB Provider for SQL Server;  

SQL Native Client 

Oracle Oracle Provider for OLE DB 

Microsoft OLE DB Provider for Oracle 

Microsoft Access Microsoft Jet 3.51 or 4.0 OLE DB Provider 

Access Users 

If you are going to use an Access database and selected a Microsoft Jet 3.51 or 4.0 OLE 
database provider, the Connection tab displays. It allows you to enter the following information: 

 Database Name – Type the Microsoft Access database file name that you want to 
access or click the ellipsis button to browse for the file. 

 User Name – Enter a valid user name for your database. 

 Password – Enter the password associated with your user name. 

 Blank Password – Select this option only if your user name does not have an associated 
password. 

 Allow Saving Password – Always select this option. Both the User name and Password 
are encrypted and the information is stored in the Datasources.dat file along with the 
connection properties. If this option is not selected, the users are prompted to log into the 
database each time they launch Open Plan and they may encounter database errors. 

One you have defined the properties of the database provider, you can test the connection by 
clicking Test Connection. A message indicates if the connection was successfully tested. If the 
test was successful, click OK twice to close the Data Link Properties dialog box. Otherwise, 
correct the properties and test the connection again. 

The Edit Data Source dialog box displays after a successful connection. 

You are prompted to name the Open Plan data source and the Database Name (Schema). 
Leave the Database Name (Schema) field blank if you are not using schemas or Access. Select 
the Database is Unicode option if tables were created with the Unicode option enabled. Click 
OK. Your new data source is now added to the list of sources in the Data Sources dialog box. 

 

The scripts for creating tables on SQL Server and Oracle default to a Unicode installation. For 
more information, see Open Plan Tables.  

To set up an Open Plan data source for a new Access database, complete the following 
steps: 

1. Click Start » All Programs » Deltek » Open Plan Professional 3.5 » Tools » Data 
Tool. 

2. On the Data Tool Login dialog box, enter PASSWORD as the password, and click OK. 
For security purposes, you should change this password as soon as possible. 
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You can change the password by clicking Password in the Open Plan Data 

Administrator dialog box, which is displayed after you log on. 

3. On the Open Plan Data Administrator dialog box, click  at the right edge of the Target 
DSN field. 

4. On the Data Sources dialog box, click Add. 

5. On the Provider tab of the Data Link Properties dialog box, select the appropriate 
database provider from the list. 

6. Click Next. 

7. On the Connection tab, enter the following information: 

 Database name 

 Valid user name and password for the database  

 

If you want to save your name and password, select the Allow saving password 

option. 

8. Click Test Connection. 

9. When a message displays indicating that the connection tested successfully, click OK. 

10. Click OK. 

11. On the Edit Data Source dialog box, enter a name for the Open Plan data source. Leave 
the Database Name (Schema) field blank. 

12. If tables were created with the Unicode option enabled, select the Database is Unicode 
option for Unicode support. 

 

The scripts for creating tables on SQL Server and Oracle default to a Unicode 
installation. For more information, see Open Plan Tables. 

13. Click OK. The new data source is now added to the list on the Data Sources dialog box. 

14. Click OK to return to the Open Plan Data Administrator dialog box. 

Oracle Users 

If you selected an Oracle provider on the Provider tab of the Data Link Properties dialog box, the 
Connection tab displays. It allows you to enter the following information: 

 Server Name – Enter the appropriate server name. 

 User Name – Enter a valid user name for your database. 

 Password – Enter the password associated with your user name. 

 Blank Password – Select this option only if your user name does not have an associated 
password. 

 Allow Saving Password – Always select this option. Both the User Name and the 
Password are encrypted and the information is stored in the Datasources.dat file along 
with the connection properties. If this option is not selected, the users are prompted to log 
into the database each time they launch Open Plan and they may encounter database 
errors. 
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For Oracle, you can either set up an account (user name and password) that automatically 
restricts access to a specific schema, or use a general account and specify the schema name in 
the Edit Data Source dialog box. 

After you have defined the properties of the database provider, you can test the connection by 
clicking Test Connection. A message indicates if the connection was successfully tested. If the 
test was successful, click OK twice to close the Data Link Properties dialog box. Otherwise, 
correct the properties and test the connection again. 

The Edit Data Source dialog box displays after a successful connection. 

You are prompted to name the Open Plan data source and the Database Name (Schema). The 
Database Name (Schema) field is required if the Oracle Account used has access to more than 
one schema in the Oracle database. Select the Database is Unicode option if tables were 
created with the Unicode option enabled. When you click OK, your new data source is added to 
the list of sources in the Data Sources dialog box. 

 

The scripts for creating tables on SQL Server and Oracle default to a Unicode installation. For 
more information, see Open Plan Tables. 

To set up an Open Plan data source for a new Oracle database, complete the following 
steps: 

1. Click Start » All Programs » Deltek » Open Plan Professional 3.5 » Tools » Data 
Tool. 

2. On the Data Tool Login dialog box, enter PASSWORD as the password, and click OK. 
For security purposes, you should change this password as soon as possible.  

 

You can change the password by clicking the Password button on the Open Plan Data 
Administrator dialog box, which is displayed after you log on. 

3. On the Open Plan Data Administrator dialog box, click  at the right edge of the Target 
DSN field. 

4. On the Data Sources dialog box, click Add. 

5. On the Provider tab of the Data Link Properties dialog box, select the appropriate 
database provider from the list. 

6. Click Next. 

7. On the Connection tab, enter the following information: 

 Server name 

 Valid user name and password for the database 

 

If you want to save your user name and password, select the Allow saving Password 

option. 

8. Click Test Connection. 

9. When a message displays indicating that the connection tested successfully, click OK. 

10. Click OK. 
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11. On the Edit Data Source dialog box, enter a name for the Open Plan data source and the 
Database Name (Schema). This field is used to identify the source.  

12. If tables were created with the Unicode option enabled, select the Database is Unicode 
option for Unicode support.  

 

The scripts for creating tables on SQL Server and Oracle default to a Unicode installation. 
For more information, see Open Plan Tables. 

13. Click OK. The new data source is added to the list on the Data Sources dialog box. 

14. Click OK to return to the Open Plan Data Administrator dialog box. 

 

After you have added an Open Plan data source for a new Oracle database, see the 
“Loading Default Data” section of this document to set up your data and continue with 
the installation process. 

SQL Server Users 

If you selected a SQL Server provider on the Provider tab of the Data Link Properties dialog box, 
the Connection tab displays. It allows you to enter the following information: 

 Server Name – Select or enter the appropriate server name. 

 Information to log on to the server – Select whether to use Windows NT Integrated 
Security or to use a specific user name and password. If you elect to use a specific User 
name and Password, enter a valid user name and password for your database. 

 Blank password – Select this option only if your user name does not have an associated 
password. 

 Allow saving password – Always select this option. Both the user name and password 
are encrypted and the information is stored in the Datasources.dat file along with the 
connection properties. If this option is not selected, the users are prompted to log into the 
database each time they launch Open Plan and they may encounter database errors. 

 Select the database on the server – Select the appropriate database to use on the 
server by default. This name is used to identify the data source in the Data Sources 
dialog box. 

 Attach a database file as a database name – Select this option if you want to attach a 
database file directly. 

Once you have defined the properties of the database provider, you can test the connection by 
clicking Test Connection. A message indicates if the connection was successfully tested. If the 
test was successful, click OK twice to close the Data Link Properties dialog box. Otherwise, 
correct the properties and test the connection again.  

The Edit Data Source dialog box displays after a successful connection. 

You are prompted to name the Open Plan data source and the Database Name (Schema). If you 
selected a database name on the Connection tab of the Data Link Properties dialog box, leave 
the Database Name (Schema) field blank if you are not using schemas or Access. Select the 
Database is Unicode option if tables were created with the Unicode option enable. When you 
click OK, your new data source is added to the list of sources in the Data Sources dialog box. 

 

The scripts for creating tables on SQL Server and Oracle default to a Unicode installation. For 
more information, see Open Plan Tables. 
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To set up an Open Plan data source for a new SQL Server database, complete the 
following steps: 

1. Click Start » All Programs » Deltek » Open Plan Professional 3.5 » Tools » Data 
Tool. 

2. On the Data Tool Login dialog box, enter PASSWORD as the password, and click OK. 
For security purposes, you should change this password as soon as possible.  

 

You can change the password by clicking the Password button on the Open Plan Data 
Administrator dialog box, which is displayed after you log on. 

3. On the Open Plan Data Administrator dialog box, click  at the right edge of the Target 
DSN field. 

4. On the Data Sources dialog box, click Add. 

5. On the Provider tab of the Data Link Properties dialog box, select the appropriate 
database provider from the list. 

6. Click Next. 

7. On the Connection tab, enter the following information: 

 Server name 

 Valid user name and password for the database 

 

If you want to save your user name and password, select the Allow saving Password 

option. 

8. Click Test Connection. 

9. When a message displays indicating that the connection tested successfully, click OK.  

10. Click OK. 

11. On the Edit Data Source dialog box, enter a name for the Open Plan data source.  

12. If you selected a database name on the Connection tab of the Data Link Properties dialog 
box, leave the Database Name (Schema) field blank if you are not using schemas or 
Access. 

13. If tables were created with the Unicode option enabled, select the Database is Unicode 
option for Unicode support. 

 

The scripts for creating tables on SQL Server and Oracle default to a Unicode 
installation. For more information, see Open Plan Tables. 

14. Click OK. The new data source is added to the list on the Data Sources dialog box. 

15. Click OK to return to the Open Plan Data Administrator dialog box.  

Load Default Data 

After you have added a data source, the Open Plan Data Administrator dialog box displays, 
allowing you to set up the default data. 
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Running the data tool erases all data of the specified type in the data source that you use it 
against. If you already have another edition of Open Plan installed and you want to update the 
data, see the “Loading Data for an Additional Product” section of this document. 

Using this dialog box, select the data source you created in the Edit Data Sources dialog box 
from the Target DSN field. 

Select the appropriate fields on the Initialize Data Source tab: 

 The Install default data option needs to be run only once for a data source. It will refresh 
the data dictionary, security data, system library, explorer folders, spread curves, views, 
title blocks, bar sets, and symbols. You must indicate the product or products (Open Plan 
Professional or Open Plan Desktop) for which you would like the data to be created. 

 If you select the Remove existing data option, all data in the data source will be 
removed before the default data is installed. 

 The Install demonstration data option installs the demonstration projects Clean, Constr, 
Develop, Movie, Movie15, Pharmacy, STS-65, Ship, and Tour. To install the 
demonstration data, you must select the Remove Existing Data option. 

To load default data, complete the following steps: 

1. On the Open Plan Data Administrator dialog box, select a Target DSN from the list. This 
is the data source you created when initializing the data source. 

2. Select Install Default Data.  

3. Select Open Plan Professional and/or Open Plan Desktop, depending on the version 
of Open Plan you installed. 

4. To install the demonstration data, select Remove Existing Data, and then select Install 
Demonstration Data. 

5. Click Create Data.  

6. After the data has been created, click Close. 

Load Data for an Additional Product 

You can choose to update data if you currently have data sources set up from another edition of 
Open Plan (Desktop or Professional). 

 

If you choose to install the default data on the Initialize Data Source tab, the data tool will refresh 
all data of the specified type in the data source that you use it against. You may lose saved 
information within your data dictionary, security data, system library, explorer folders, spread 
curves, views, title blocks, bar sets, and symbols. 

To update the data, click the Add Products tab on the Open Plan Data Administrator dialog box. 
The Add Products tab allows you to add products to data sources, allowing Open Plan 
Professional and Desktop editions to use the same data sources. The tab offers the following 
options: 

 Choose Product – A list containing Open Plan products not already set up on your 
system. 

 Install Default User Account – Allows you to reset default user accounts and 
passwords for SYSADMIN and GUEST. 

 Delete All Existing Users – Removes all current users from the data source.  
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Click Create Data to add the new product to the data source. A dialog box will indicate when the 
transfer is complete. 

To update data for an additional product, complete the following steps: 

1. On the Open Plan Data Administrator dialog box, click the Add Products tab. 

2. From the Choose Products drop-down list, select the product you want to add. 

3. If you want to reset default user accounts and passwords for SYSADMIN and GUEST, 
select the Install Default User Account option. 

4. If you want to remove all current users from the data source, select the Delete All 
Existing Users option. 

5. Click Create Data.  

6. When the transfer is complete, click OK. 

7. On the Open Plan Data Administrator dialog box, click Close. 
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Launching the EPM Security Administrator 

Use this procedure to launch the EPM Security Administrator, where you can set up security for 
Open Plan. 

To launch the EPM Security Administrator, complete the following steps: 

1. Click Start » Programs » Deltek » Open Plan Professional 3.5 » Security » EPM 
Security Administrator. 

2. On the EPM Security Administrator dialog box, log on as SYSADMIN in the User ID field 
and enter password in the Password field. 

3. Click OK. 

4. Click Tools » Programs » Change data source… to display the Data Sources dialog 
box. 

5. Select the appropriate data source and click OK. The default data source is OP35. 

Set Up Security 

In the Deltek EPM Security Administrator, there are currently two groups defined: SYSADMIN 
and GUEST. The administrator lets you add new groups and users as well as define their 
properties. For each user you add, the User Details form lets you define the user ID and 
password. 

 

To launch Open Plan, each user needs an ID and password and must belong to at least one 
group. 

You may find that you need to create a number of user profiles very quickly. Frequently, these 
users already exist as entries in another application such as Microsoft Outlook™ or Windows 
Active Directory. The Deltek EPM Security Administrator provides an import facility that allows 
you to import data directly from these applications. In addition, you can also import data from a 
comma-delimited ASCII file. 

 

For more information about importing users into the Deltek EPM Security Administrator, see the 
EPM Security Administrator Guide. 

After you have set up users and groups, you can add users to groups. 

Create a User 

To create a new user, complete the following steps: 

1. Log on to the EPM Security Administrator. 

2. Select Open Plan as the product. 

3. To create a new user, select the Users folder, and click Edit » Add on the toolbar. 

 

You can also right-click the Users folder and click Add on the shortcut menu. 
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4. To define the user’s properties, click the General tab. 

Create a Group 

To create a new group, complete the following steps: 

1. To create a new group, click the Groups folder, and click Edit » Add on the toolbar.  

 

You can also right-click the Groups folder and click Add on the shortcut menu. 

2. Enter a name for the new group. To define the group’s properties, click the General tab. 

Add a User to a Group 

To add a new user to a group, complete the following steps: 

1. After you have created a new user, click a group in the Groups tab.  

2. Click Add. 

3. On the Add Users dialog box, select the user that you want to add to the selected group, 
and then click OK. 

4. When you have finished adding groups and users, click Exit on the System menu.  

 

A user must be a member of at least one group to have access to Open Plan. 
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Open Plan Folder Permissions 

When installing Open Plan Professional and Desktop systems on a network, the following 
network access rights must be provided to users: 

 

 

The \Workstation Setup folder is added only for server installations. 

OPP Folder OPD Folder Required Access Rights 

Opp Opd Read 

\Documentation \Documentation Read 

\Help \Help Read 

\Sample Data \Sample Data Read 

\Sample Tools \Sample Tools Read (or write if the users 
want to modify the sample 
source code) 

\Spell \Spell Write (to add words to 
dictionary) 

\SQL \Sql Read (Write to use the default 
Access database) 

\Symbols \Symbols Read 

\User \User Read 

\Workstation Setup \Workstation Setup Read 
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Modifying, Repairing, or Uninstalling Open Plan 

Open Plan provides facilities for changing which features are installed, repairing installation 
errors, and removing Open Plan. Use the procedure in this section to change your Open Plan 
installation structure.  

To modify, repair, or remove your Open Plan installation, complete the following steps: 

1. Launch the MS Windows Control Panel. 

2. Click Programs and Features.  

3. On the Programs and Features list, right-click Deltek Open Plan Professional 3.5 and 
click Change on the context menu. The Open Plan 3.5 Setup Wizard displays. 

4. Click Next. 

 

5. On the Modify, Repair, or Remove Installation page, select one of the following 
options, depending on the task that you want to do: 
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 Modify — Select this option to change your Open Plan installation structure. 
Selecting this option displays the Custom Setup page. 

 Repair — Select this option to repair installation errors by reinstalling the Open Plan 
components. Selecting this option displays the Repair Open Plan 3.5 Installation 
page. Click Next to continue repairing Open Plan. 

 Remove — Select this option to uninstall Open Plan from your machine. Selecting 
this option displays the Remove Open Plan 3.5 Installation page. Click Next to 
continue uninstalling Open Plan. 

6. When the process is completed, click the Finish button to exit the Setup Wizard. 
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Where to Go from Here 

Open Plan includes a number of tools to help you learn about the features and operations of the 
product. 

The Open Plan Guided Tour lets you take a hands-on tour of many of the Open Plan features. 
Use this documentation if you’re interested in getting a closer look at some of the tools Open Plan 
can offer project planners. 

For more comprehensive information about Open Plan, examine the Deltek Open Plan User 
Guide. This PDF file contains complete descriptions of the various features found in Open Plan, 
and includes procedures for carrying out many common tasks. Chapter 2, “Basic Skills,” and 
Chapter 3, “Getting Started,” will help you master the basics of project planning in Open Plan. 
The remaining chapters are organized on the basis of topics such as entering activity information 
and project analysis, and do not have to be read in any particular order. 

The Open Plan help system contains a wealth of information about using Open Plan and is 
available whenever you need it. For more complicated features, look for an Examples button in 
the help window for an extended explanation of the feature. To print a help topic, click the Print 
button within the help system. 

For in-depth information about advanced topics, check the Deltek Open Plan Developer Guide. 
This PDF file includes information on topics such as customizing project views, data file 
structures, compatibility issues, and OLE automation techniques. 

For information on training courses offered on Open Plan, visit our Web site at www.deltek.com. 
Click Education » Browse Courses. On the My Deltek University page, browse for Open Plan 
courses in the Browse for Training pane. 
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Appendix:  Deltek Open Plan 3.5 Terminal 
Services (Remote Desktop Services)/Citrix 
Installation  

Overview 

This appendix is an addendum to the Open Plan 3.5 Installation Guide. It is designed to explain 
the additional steps required to install Open Plan 3.5 in a shared application server (MS Terminal 
Server/Remote Desktop Services or Citrix XenApp Server) environment. 

Version Information 

The appendix applies to Open Plan 3.5. Open Plan has been tested by Deltek on MS Windows 
Server 2008 Terminal Server and Windows Server 2008 R2, 2012, and 2012 R2 Remote Desktop 
Services. 

Beginning with Windows Server 2008 R2, Terminal Services was renamed Remote Desktop 
Services. In addition to the name change, the deployment and configuration of Remote Desktop 
Services have changed significantly. For guidance on deploying the Remote Desktop Services 
Role and Features, refer to the Microsoft Remote Desktop Services documentation page 
(https://technet.microsoft.com/en-us/windowsserver/ee236407).   

 

In this appendix, the terms “Terminal Services” and “Remote Desktop Services” are used 
interchangeably. 

Many customers use Open Plan on Citrix XenApp Server. Citrix offers more sophisticated load 
balancing capabilities and provides solutions for cross platform remote access. 

Important Information 

For improved application performance, Deltek strongly recommends that all application software 
be accessed in a Terminal Server/Remote Desktop Services environment installed locally on the 
Terminal Server/Remote Desktop Session Host application server. For Windows 2008 R2 or 
higher, when deploying the Remote Desktop Services role, the session-based desktop 
deployment scenario is recommended and is comparable to the deployment of Windows 
Terminal Services of Windows 2008 and earlier versions. 

If both Open Plan Professional and Open Plan Desktop are installed on the same application 
server and some users will have less than Power User rights, then an additional manual step is 
required to avoid unexpected errors. Please see the section on Open Plan Desktop toward the 
end of this document. 

Database Connections 

The two most important factors affecting Open Plan performance are memory available to the 
application and database performance. Deltek recommends that Open Plan is used with either 
SQL Server or Oracle in a multi-user environment and that the database server is close to the 
Terminal Server/Remote Desktop Session Host application server. Smaller implementations can 
install the database software on the Terminal Server/Remote Desktop Session Host itself but for 
larger implementations (more than 10 users) we recommend a separate database server. We 
suggest that the Terminal Server and database server are connected to the same network switch 

https://technet.microsoft.com/en-us/windowsserver/ee236407
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and that if the solution will be supporting many users then serious consideration should be given 
to a Gigabit link. 

Server Sizing 

We recommend that you follow the application server supplier guidelines for server sizing. Open 
Plan falls into the knowledge worker category for sizing purposes. In the absence of other advice 
Deltek suggests 200MB for the system and 50MB per concurrent user. Accepted wisdom is that 
one fast processor is more advantageous than 2 slow processors so we would suggest 
considering a dual 3 GHz solution over a quad 1.5 GHz solution (a quad 3 GHz is better). 

Terminal Server/Citrix Installation  

The recommended approach for Terminal Server/Citrix installation is to install the application 
locally on the server using the Complete installation option. The appropriate menu options will be 
added for all users. Terminal Server/Citrix will automatically create appropriate registry entries for 
each user. Open Plan will automatically create the required user files when first launched in the 
users My Documents folder (see Modifying the User Directory for details of how to change this 
behavior) 

When a Terminal Server is in Application Server mode (required to support remote access by 
more than 2 users) the Server must be placed into Installation Mode so that it will correctly copy 
application registry keys for new users. The correct way to enter Installation Mode is to use the 
Programs and Features option in the Control Panel. 

In Programs and Features, find and double-click Deltek Open Plan Professional 3.5.0.exe. 
Select the Complete Installation. 

Security Considerations 

Make sure the users requiring Remote Desktop access are members of the Remote Desktop 
Users group or that the users have been granted Terminal Server logon rights through the local 
security policy (Administrative Tools; Local Security Policy).
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The limited user group must be granted MODIFY access to the default MS Access database if 

this will be used.  

 

If this data source will not be used then the Administrator must update the Open Plan 
DATASOURCES.DAT file with the appropriate connection settings for the required database. 

Logon as the limited user 

Run Open Plan (menu and desktop items should automatically appear). 

The user’s My Document folder will be updated to include a Deltek folder containing the Open 
Plan working files, including the BRIEFCASE database and SPELLING DICTIONARIES, among 
others. 
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Modifying the User Directory 

Open Plan 3.5 defaults to creating the user working directory as a subfolder of the current users 
My Documents\Deltek folder. It is possible to globally modify this behavior by adding the 
following line to CONFIG.DAT in the root of the Open Plan installation. 

[SYSTEM] 

UserDir=N:\OPP 

This would cause Open Plan to create the Open Plan files in the folder N:\OPP. It is the System 
Administrator’s responsibility to ensure that this represents a unique location for each user. This 
means that typically Drive N: must be mapped as part of the login process, taking care to map to 
a different physical folder for each user. 

Open Plan Desktop 

If both Open Plan Professional and Open Plan Desktop are to be installed on the same 
application server and some users will not have Administrator or Power User rights then some 
additional steps are required to avoid users receiving a message that Open Plan is not correctly 
installed. 

When Open Plan (any version/edition) starts, it checks to see if the version number or installation 
location of the OLE Server components of the product has changed. Since both Professional and 
Desktop editions include the same OLE Server components changing between editions will be 
detected as a re-install which will cause Open Plan to attempt to re-register the OLE Server 
component. This requires write access to the HKEY Local machine registry hive. Regular users 
do not have this access right. 

The current workaround to this issue is as follows: 

As Administrator, perform the following steps: 

1. Install Open Plan Professional (as above). 

2. Install Open Plan Desktop. 

3. Execute (start and exit) Open Plan Professional. 

4. Manually copy the Open Plan Desktop executable (OPD35.EXE) into the Open Plan 
Professional installation folder (C:\Program Files\Deltek\Open Plan Professional 3.5). 

5. Modify the Open Plan Desktop menu shortcut to the new location. 

 

 

 

 

 

 

 

 

 

 



 

 

 

Deltek is the leading global provider of enterprise software and information solutions for professional 
services firms, government contractors, and government agencies. For decades, we have delivered 
actionable insight that empowers our customers to unlock their business potential. Over 14,000 
organizations and 1.8 million users in approximately 80 countries around the world rely on Deltek to 
research and identify opportunities, win new business, optimize resource, streamline operations, and deliver 
more profitable projects. Deltek – Know more. Do more.
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